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2 System requirements 

2.1 Computer 

A PC with the following specifications is required to use the software: 

Processor type Intel® Pentium or comparable, e.g. AMO® or Cyrix® 

Operating system Microsoft® Windows 95/98/NT®/2000/XP® 

RAM At least 64 MB 

Hard disk memory At least 50 MB free memory 
You require more memory space if you want to save protective field 
or configuration values. 

Screen display Color 

External drive CD drive 

Input device Keyboard and mouse or touch pad 

Output device Printer (black and white or color) 

Serial interface RS232 or RS422 

Use an appropriate adapter if the PC has a USB interface instead of 
a serial interface. 
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3 AG4soft Overview 
The AG4soft program is used to both establish operational settings for the Scanner and to display measurement and system information produced by the 
scanner. Communication between the PC and the AG4 is via an RS232 interface, either RS232-to-RS232 or USB-to-RS232. 

0 
'fl 

Use this software only for Banner AG4 Series Safety Laser Scanner. 

3.1 Configuration 

The AG4 Scanner is preprogrammed at the factory with a default configuration but must be reconfigured for each application. The factory default 
configuration is stored as a file (standard.rs) in the AG4soft program directory during the software installation on the PC: 

C:\Program Files\Banner Engineering\Banner AG\AG4soft\examples 

3.1.1 Configuring the AG4 

The configuration settings are created by a trained and Qualified Person who understands the AG4 instruction materials. These settings are saved in a 
configuration file which has the *.rs file format and includes all the information that the AG4 requires for its intended operation. An AG4's configuration file 
includes the following data: 

Administrative data, e.g. file name, application description 
Safety-relevant data, e.g. startup process 
Protective Field or warning field configuration data, e.g. contours and limits 

A wizard in the program assists users with the AG4 configuration process. 

3.1.2 Protective and Warning Fields 

The software makes it easy to establish protective and warning fields. The protective field and the warning field are user defined areas that the Scanner 
monitors. An intrusion into the protective field (e.g. a person walking into a monitored work cell) will cause the Scanner to turn its safety outputs off. An 
intrusion into the warning field will cause the Scanner to create a warning signal. 

Protective field and warning field settings are created and saved as field pairs. Up to 8 configurable field pairs are available for the AG4. A field 
configuration file has the *.sf file format and includes data on the size of each protective and warning field. Field pairs can be enabled or disabled, one 
field pair at a time, while the Scanner is operational and actively monitoring a work area. This function is useful when changing machine guarding 
requirements create the need for changes in protective and warning field dimensions. 
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Table 3. Status Information Area available data 

Display Status 

AG4 ·PC Communication 

AG4 synchronous PC synchronizes the connection between the PC and the AG4 

AG4 connection Data transfer between PC and AG4 is possible 

AG4 Status 

AG4 -> Measurement mode Software receives measurement data from the AG4 

AG4 -> Configuration Software transfers configuration data to the AG4 (OSSDs are OFF) 

AG4 ->Error Error in the AG4 {OSSDs are OFF) 

AG4soft Operating mode (identifies the active Worksheet) 

PC-> Measured value display Measured contour (monitored surfaces) display tools are active 

PC -> AG4 configuration Configuration tools are active 

PC -> Protective/warning field 
Protective/warning field tools are active 

definition 

PC-> AG4 system data System data tools are active 

Protective/warning field 

PF, WF red Protective and Warning fields interrupted (OSSDs are OFF) 

WF green Warning field interrupted 

Empty Protective and Warning fields clear 

Logged-on authorization level 

Operator (Op) User is logged in with the Operator (Op) authorization level 

Maintainer {Ma) User is logged in with the Maintainer (Ma) authorization level 

Authorized Customer (AC) User is logged in with the Authorized Customer (AC) authorization level 

Production {Pr) User is logged in with the Production (Pr) authorization level 

Development (De) User is logged in with the Development (De) authorization level 
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5 Configuring the Scanner (Setting Operational Parameters) 

5.1 Configuration Requirements 

Configuring the AG4 requires: 

• Connecting PC to AG4 (via RS232) 

• Starting software and logging in as user 

• Creating or editing an AG4 configuration with the wizard 

• Creating protective field and/or warning field settings 

• Downloading the configuration to the AG4 

• Checking echo data (confirming the AG4 settings) 

5.2 Installing software 

NOTE: The AG4 is not required for installing the software on the PC. 

Requirements: 

• If the PC and AG4 are already connected with one another, turn the AG4 power OFF. 

• Close all other Windows applications. 

1. Insert the CD ROM. 

The installation boots up automatically. 

2. Open the Disk1 folder and double-click on the setup.exe file. 

If the installation does not start automatically from the CD drive, open the folder \AG4soft\Disk1 and double-click the setup.exe file. 

The installation wizard starts. 

3. Click on [Next] . 

The installation wizard opens the software license agreement. 

4. To agree with the software license contract, click Yes. 

5. To agree with the recommended installation path, click Next. 
or, 

6. To enter another path, Click on Browse. 

7. Select another path and click on OK , then Next. 

The wizard installs the software and creates a link on the desktop. 

5.3 User Authorization 

The following section describes the AG4soft program function access for each authorization level and the login process. 

5.3.1 Authorization Level 

The Authorization level login permits access to program functions on a need-to-use basis. In other words, the functions that are available depend on the 
selected authorization level. Functions (buttons) that are not actionable in the software program appear as grayed-out versions of the original button. 

No individual user names are required for the login, but an authorization level must be selected. 

The functions for each authorization levels are listed below: 
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If a single value parameter has been selected, a sub-menu opens to the right of the status field. The current selection is shown and an entry field for 
the new selection is provided. 

- Ji Configuiation p0famete1s 
CJ Admiristrative P01amete1s 
E:i Solety·relevant Pafamele<s 

• CJ Fieldpairl 
• CJ Freldpair2 
t CJ Fieldpair3 
• CJ Freldpair4 
• CJ Fieldpair5 
• CJ Freldpair6 
• CJ Fieldpair7 

@)Application 
(!!)Response times 
(!!)Start segment measlKement 0" 0.36• 
@)Stop segment measurement 528 • 0.36· 
(!!)Dust suppression Activated 
(!!)Permitted field pal switchovers 
(!!)Valid f.ekt pair selecbon with scameJ start 

@)SK Data Ve"ion 
@)SK Data ID 40476 
@)Dateollostsave 00:0001 .01 .1~ 

Cooligu"ation parameters\Safety-relevant parameters 

Figure 5 Configuration Parameters Menu 

4. Select New Value for parameter as required then click Accept. 

5. To print the configuration, in this menu click Print. 

6. To save the configuration in the *.txt format click Create text file. 

A 
A 

A 
A 
A 

If a multi value parameter has been selected, a pop-up menu opens, showing the current values. 

Configuration parameters 

20 

Application 

I Danger zone guarding 

Resolution 

Restart behe.vior 

<" 
r 

I Ornm 

Sofety-relevant porometers 

Selection of the planned application and area of use 
of the Safety Loser Scanner 

w;th definition of the requested resolution. 

Th rs preselee1Jon defines further solely-relevant pororneters ond 
speafic protectrve field def1mtmns! 

Start behovior after swi1ching on the Laser Sconner. 
Caution: 
With 'Automatic start' selection a start warning 
(opticoVocoustic) 
must be provided for or you must pororneter the downstreorn safety 
device with the 'Start interlock' fune1Jonl 

Safety Loser Scanner start behe.vior 
after release of the protective field PF during running operotion, 

QK .Qoncel 
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Current value 

!Activated 

New value 
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QK 

Qancel 

Erint 

Create tex1 file 

Banner AG4 So~ware Manual 

Buy: www.ValinOnline.com | Phone 844-385-3099 | Email: CustomerService@valin.com



Banner AG4soft Software Instruction Manual 

7. Select the appropriate fields as necessary and when complete, click OK. 

8. When all required parameters have been changed confirm with OK in the configuration main menu. 

The changed configuration can now be downloaded to the AG4 or saved in a file. 

If the operating mode is changed before the changed configuration has been downloaded or saved, the Memory message appears: 

The changed configuration data has not been saved yet 

i;; Tran sf er data from PC to scanner. 

r SavedatafromPCinafile. 

QK Discard Qe.ncel 

r Do not display message any more. 

9. Ensure that the appropriate checkboxes are checked and confirm with OK 

The program executes the selected functions, or 

10. To discard all changes to the configuration, click on the Discard button, 

the program reverts to the previous configuration, or 

11. To edit the configuration, click on Cancel. 

Banner AG4 Software Manual 144923 rev. A 0212010 21 

Buy: www.ValinOnline.com | Phone 844-385-3099 | Email: CustomerService@valin.com



 







Banner AG4soft Sl)ftwar~ lnstructil)n Manual 
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5. 7 Create and edit protective/warning field configuration 

To create a new protective/warning field configuration, load an existing protective/warning field configuration and change its field boundaries and save as 
a new file. 

0 
Tl 

An AG4 configuration must be loaded into the software so that changes can be made to 
protective or warning fields. The data of an individual protective or warning field configuration 
can be saved as its own file. When the AG4's configuration file is saved, the protective or 
warning field file is automatically included in the AG4's configuration file. 

5.7.1 Load protective/warning field configuration 

To create or edit a protective or warning field configuration, load an existing protective/warning field configuration into the AG4sofl program. 

Requirements: 

1. 

Logged in with the Authorized Customer (AC) authorization level. 

A configuration file is loaded in the software. 

Click on the Protective/warning fields definition worksheet tab and click ~. 
or, using the drop down menu select: 

2. File> Load protective/warning field from a file. 
Select a hie to open. L7)[8] 

The AG4 examples folder opens. 

3. Select the file that you want and click Open. 

The protective and warning fields appear in the 
AG4sofl worksheet display area. 

look " I o • ........, 

L0 ;:J .. ando<d.sf 

My Reem 
D°"""""'' 

OJ 
Desktop 

~ 
My Ooo.ments 

SJ 
My~er 

MyNetwoik 
Piao .. 

Fie[.!o¥1le: 

Fleoolll<>« 

3 +- i!Jd lm!l· 

~ 
'""ectNe,..., ,., r.UJ 3 ~ 

NOTE: Individual protective or warning field configurations can be loaded from a file. If an AG4 configuration is already loaded, all defined 
protective/warning fields in it are automatically loaded. 
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Set as many coordinate points as needed to shape the field. 

(see work space right for example) 
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5.7.8 Blank out segments 

Individual field segments can be blanked out or not monitored, by establishing two points on either a protective or a warning field boundary. The program 
creates the unmonitored region between the points. The unmonitored region boundaries extend along a radial line to the AG4 

34 

1. Click the Protective/warning fields definition worksheet tab and click ~. 
or, using the drop down menu select: 

2. Protective/warning fields> Blank out 
protective/warning field segment. 

The pointed index finger cursor appears. 

3. Click on the 1'1 point on the field 

(see work space right for example 

4. Click on the 2•d point on the work space 

5. Right click 

The new field shape appears with the unmonitored section 
clearly visible in the workspace. 
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0 
'il 

When setting the reference surface, ensure smooth transitions between protective field with reference contour and 
protective field segments without reference contour. The reference contour must lie on the measured contour; the 
protective field limit slightly before the measured contour. 

1. Click the Protective/warning fields definition worksheet tab and Click ~ . 
or, using the drop down menu select: 

2. Protective/warning fields> Define protective segment as reference contour 

In the work space, 

3. Click a point on the protective field boundary. 

4. Click another point on the protective field boundary. 

5. When the button is released, the reference is established. 

The software shows a blue connection line from the starting point to the end 
point of the reference contour. 

I 

J 

I 
-·~-

If it is necessary to create a reference contour that consists of several 
sections, repeat the process until the contour corresponds with the desired 
display. 

:---+--.- - ,-----+-, ---<,c----+-, -·-,- - . 
0.900 0.600 0.400 0.200 ·0.000 ·0.200 -0..400 ·0.600 -0.900 

Uritt WI meter~ 

If it is necessary to delete a reference contour, 

1. Click the Protective/warning fields definition worksheet tab and click _gj 
or, using the drop down menu select: 

2. Protective/warning fields> Reset reference contour definition for protective field 
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The program sends to new field parameters to the AG4. A copy of the echo data for each change field is defined in the program for review. If field 
data are correct, 

4. Click on Accept. 

The program establishes and activates the new fields in Scanner and the Transfer protective/warning data from PC to Scanner message 
opens. 

5. To confirm the message, click on OK. 

The software saves and activates the changed protective and warning field files in the AG4. 
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7 Menu item reference 
An overviews of the AG4soft program menu items, icon functions and tools can be found in this chapter. 

7.1 Menu 

The Menu chapter gives an overview of all menus and menu items. 

0 
'fl 

Please note that the available menu items depend on both the selected authorization level and the selected 

operating mode. If, for example, the AG4 is to be configured, first an Authorized Customer (AC) level log in is 

needed and secondly, the AG4soft program must be in Configuration mode. 

7.1.1 File 

Table 6. Menu items in the File menu 

Menu item Function 

Load protective/warning field from a file Opens a single protective or warning field configuration file 

Save protective/warning field as a file Saves a selected protective or warning field configuration as a file. 

Load configuration data from file Opens an AG4 configuration file. 

Save configuration data as a file Saves the loaded AG4 configuration as a file. 

Exit configuration program Exits the software. 

7.1.2 View 

Table 7. Menu items in the View menu 

Menu item Function 

Zoom Reduces the work space and the displayed diagram in steps. 

Un zoom Enlarges the work space and the displayed diagram in steps. 

Show all Enlarges the work space and the displayed diagram to full size of 70 x 70 meters. 

Save diagram as a file Saves the displayed diagram as a bitmap file in the *.bmp format. 
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7 .1.3 Sett in gs 

Table 8. Menu items in the Settings menu 

Menu item Submenu Function 

Measured contour display Changes to the Measured contour display operating mode. 

Configuration Changes to the Configuration operating mode. 

Operating mode 

Protective/warning fields definition 
Changes to the Protective/warning fields definition operating 

mode. 

System data Changes to the System data operating mode. 

Interface 
Opens a dialog box in which you select the serial interface and the 
transfer rate. 

Languages 
Opens a dialog box 1n which you select the language of the interface 
texts. 

PC configuration Change diagram color 
Changes the color of the work spaoe from black to white to optimize it 

for printouts. 

Rotate contour d 1splay by 180° 
Rotates the contour display in the work space to adjust the display to 

the AG4's mounting situation. 

190° protective/warning fields 
Extends the display of the protective/warning fields for the definition 
by 10° This setting does not change the measured value recording. 

Field pair display 
0 pens a dialog box in which you select the field pairs that are to be 
displayed on the work space. 

Opens a message that displays all communication processes 

Activities list 
performed since the software was last started. 
With the MotionMonitoring function, the activities list shows the 

individual actions and provides the status of the speed monitoring 
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7 .1.4 Configuration 

Table 9. Menu items in the Configuration menu 

Menu item Function 

Wizard Opens the configuration wizard with which you change the configuration parameters. 

Change Opens a dialog in which you change individual parameters. 

Set default values in the scanner Sets the AG4's conf1gurat1on back to the default status. 

Printing Prints the configuration file. 

Load from file and transfer to scanner Opens an existing configuration file and transfers the data to the AG4. 

Get from scanner Loads the configuration file from the AG4 into the software. 

Transfer from PC to scanner Transfers the configuration file to the AG4. 

7 .1.5 Protective fields /warning fields 

Table 10. Menu items in the Protective/warning fields menu 

Menu item Submenu Function 

Protective/warning field selection 
Opens a dialog box in which you select the displayed protective/warning 
field. 

Changed protective/warning fields 
Opens a dialog box in which all protective/warning fields that were changed 

since the last save are marked. 

N umer1cal field entry 
Opens a dialog box in which you define the edges of a selected 

protective/warning field. 

Elliptica I zone 
Enables an elliptical protective/warning field to be defined on the work 

space. 

Define 

Rectangular zone 
Enables a rectangular protective/warning field to be defined on the work 
space. 

Polygon zone 
Enables a polygonal protective/warning field to be defined on the work 
space 

Change 
Change protective/warning field 

Enables a seg men! to be changed 1 n the selected protective/warning field 
segment 

48 144923 rev. A 0212010 Banner AG4 So~ware Manual 

Buy: www.ValinOnline.com | Phone 844-385-3099 | Email: CustomerService@valin.com



Banner AG4soft Software Instruction Manual 

Change protective/wa ming field Enables a segment of all protective or all warning field boundaries to 0e 
segment for all field changed at the same time. 

Reduce zone limits 
Opens a dialog box in which you reduce the zone limits of the selected 
protective/warning field. 

Blank out segments 
Enables a segment to be blanked out in the selected protective/warning field 
contour. 

Set 
Enables a reference contour to 0e defined in the selected protective field 
contour 

Reference contour 

Reset 
Enables a reference contour to 0e highlighted in the selected protective field 

contour 

Delete Deletes the selected protective or warning field. 

Printing 
Prints the graphic display and some parameters of the selected 

protective/warning field. 

Transfer from PC to scanner 
Transfers one or more selected protective/warning field configurations to the 

AG4. 

7 .1.6 System data 

Table 11. Menu items in the System data menu 

Menu item Function 

Load status information from the AG4 Transfers the status information from the AG4 to the software. 

Display the scanner's diagnostics list Loads an incident list from the AG4 and opens the list in a dialog box. 

Create service file Opens a dialog box to save the service file in the *.sdc format. 

Calibrate the front screen Opens a dialog in which you calibrate a new front screen. 

Reset scanner 
Resets the safety-related switching outputs on the AG4 {Reset), required, for example, 

after cleaning 
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7.1.7 Security 

Table 12. Menu items in the Security menu 

Menu Item Function 

Change authorization level Opens a dialog box in which you can log in with another authorization level 

Change password 
Opens a dialog box in which you enter a new password for the selected authorization 

level for the login on the AG4. 

Opens a dialog box in which you enter a new password for the Authorized Customer 
Reset password (AC) authorization level for the login on the AG4. 

Need to contact Banner for access to this function. 

7.1.8 Help 

Table 13. Menu items in the Help menu 

Menu item Function 

AG4 Product Manual Opens the AG4's Product manual as a PDF file. 

AG4soft Manual Opens the AG4soft configuration and diagnostics software manual as a PDF. 

AG4 Applications information Opens copy of the AG4 reference material 

AG4 System Checkout summary Opens copy of the AG4 Checkout procedures 

7.2 Interface Button Functions 

The AG4soft interface has worksheet tool bars to display buttons for various functions summarized in the tables below. 

7.2.1 Common Worksheet Buttons 

Table 14. List of buttons and associated functions 

Icon Button/Function Comment 

§J Zoom Reduces the work space and the displayed diagram in steps. 

~ Unzoom Enlarges the work space and the displayed diagram in steps 

~ Show all Enlarges the work space and the displayed diagram to full size of 70 x 70 meters. 

~ Opens the Change authorization level dialog box. You can log in with another 
Change authorization level authorization level. 

Ji] Exit configuration program Exits the software 
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7.2.2 Me~sured ¢ontour display buU6ns 

Table 15. Mt.a~u11d contour display button.a 

Icon Bullon.•Func.tion Commenl 
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7.2.3 Configuration buttons 

Table 18. Configuration bultong 

Icon BuHvti.'F u nclion Commant 

!i l.oc:1J ·:r;nli;iura.or 1<>1<: lr::-·r 6-:: A::::c.N::~ lh: AG4 rol~cr lo• :;::rdiyJr.:li::n Iii:: -c•1i::·1i· :.Td1r:19::~ 

ill Sa11a i:tni\JUl"'dli::n d11.a ai: a ·1a s~··;i .. corrgurdtiln ·1a ir lh: f::~Ji;r 

Bl Frir. tor· gL ~.:ili;n Jr .. ll Pr11W1<>1<: 

i!U l.oc.'J .7;nli~ur11.or 1:.ili:. lr::-·r 11 6a ard .-d"~·:r 1; ~n·1ar O::ero :::.llliyJrc .. r;n lilc 1111r s"11'1ds ii 1; .··e A34 

Bl R~.ria• .. a;; ::11169Jrc.li::n d<l.a h11n i:carru~· 

iJJ I 1a11sl1,;1 :;:xlliyJrcJt-;11 ra.J 1.1111 K: lo s1:c:111::r 
S~nt S ;;. ~~li(ur;;..Kin to UlC ;..~ ~r u:::c iis. lh~ -'!(Jj·ro u:1,;f-'!tiu"~I 

wun~s 

WI c.rar~o cc·1'01.rau:n c1a~ 'MUl :1c \'.'IZ3rt $tc: b~·s::p pr.:icc:;~ for t•:g11nc~ 

~ Ct"rqe co1'~t. '31i:n dl:~1 
A::::P.'t~?.~A :iihl?. .:• r.flrAMP.I~ "'"At~.1Mnlli1i:'P.~" ::mfi9.1n;1i::n. 
S~.fllP. !"r.!TP.Mf:'l ::~n hr; ::tArg111.1 •.\ilh "1P. I.~?. af:ti~ ftnrtin"' 

_[iSl SetdefF.ultoon6;iu1atior ~·!tlu;;s n tie !:~1ng A read only fil! .1~P.:: A~A :?.mrhM -a ~~nA nF.'.,.. :::.nfi9.1n;1i~n. 

5i 

Buy: www.ValinOnline.com | Phone 844-385-3099 | Email: CustomerService@valin.com



 

Banner AG4soft Software Instruction Manual 

7.2.3 Protective/warning fields definition buttons 

The following buttons are used for specific functions in the Protective/warning fields definition worksheet. 

Table 17. Protective/warning fields definition buttons 

Icon Button Function 

~ Displayed field pairs selection 

ft Load protective/warning field from a file 

ill Save protective/warning field as a file 

fM Print protective/warning field 

No image Select protective/warning field 
A drop down field selection window in the Protective/warning field 

worksheet. Used to enable the field that in the workspace for editing purposes. 

a Enter protective/warning field numerically For setting field boundary limits numerically. 

~ Define elliptical protective/warning field For setting an elliptical field boundary shape. 

~ Define rectangular protective/warning field For setting a rectangular field boundary shape. 

~ Define polygonal protective/warning field For setting a polygon field boundary shape 

~ Change protective/warning segment For editing an existing field boundary. 

~ 
Change protective/warning segment with 

For editing all existing field boundaries at the same time. 
all fields 

~ Reduce protective/warning field limits For reducing an existing field boundary. 

~ Blank out protective/warning field segment For creating an unmonitored zone within an existing field boundary. 

~ 
Define protective field segment as For creating a reference segment within a field boundary. Used when the 
reference contour application requires a monitored reference surface for greater safety integrity. 

Jj Reset reference contour definition for 
For resetting the reference surface limits 

protective field segment 

~ Delete protective/warning field For eliminating the reference surface limits 

~ 
Transfer changed protective/warning fields 

For transferring only the protective/warning field information to the AG4. 
from PC to scanner 

52 144923 rev. A 0212010 Banner AG4 So~ware Manual 

Buy: www.ValinOnline.com | Phone 844-385-3099 | Email: CustomerService@valin.com



 

Banner AG4soft Software Instruction Manual 

7.2.4 System data buttons 

The following buttons are used for specific functions in the Protective/warning fields definition worksheet. 

Table 18. System data buttons 

Icon Button Function 

il Transfer status information from Scanner to PC For reviewing the operations settings of the AG4 

fll Display the scanner's diagnostics list Displays information needed for trouble shooting and remedial actions 

~ Create service file 

JWlJ Calibrate the front screen Used after cleaning or replacing the screen (window) 

~ Reset scanner Returns the AG4 to its factory configuration settings 
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